Contents

1 Overview 8
2 Setup 9
   My Account 9
   Voicemail and Web Suite Password 9
   Language Setting 10
   Sound Prompt Language 10
   Profile Picture 10
   Additional Numbers 11
   Phone Features 11
      General Settings 12
         Line Label 12
         Msgs Button 12
            Msgs Button Action 12
         Idle Screen 12
            Idle Screen Image 12
         Display 12
            Brightness and Contrast 12
            Backlight Dimming 12
         Sounds 12
            Default Ringtone. 12
            Reset Volume Every Call 12
   Answering 12
      Headset Answer 12
      Auto-answer Switchboard initiated calls 12
   Ringtones 13
      Creating a Ringtone 13
      Distinctive Ringtones 13
   Ring Rules 14
      Ring Settings 14
         Changing a Ring Rule or Condition 15
   Converged Phones 15
   Managing a Converged Phone 16
   Options 17
      Acknowledge Rapid Transfer 17
      Label 17
      Rapid Transfer Key 17
      Rapid Transfer Sound 17
   InCall Menu 17
Main Menu: Rapid Transfer 18
Options Menu: Transfer and Recording 18
Transfer Menu 18

3 Call Rules & Status 19
  Call Rules 19
    Unanswered Call 19
    Creating a Call Rule Set 20
    Creating Call Rule Actions for a Set 20
    Prioritizing Actions in a Call Rule Set 22
    Modifying a Call Rule 22
    Activating a Call Rule Set 23
    Busy Call 23
    Call Blocking 23
    Creating a Call Block Rule 23
  Messages/Prompts 23
  Time Frames 24
    Managing Time Frames 24
    Modifying a Time Frame 25
    Deleting a Time Frame 25
  Status Options & Status App 25
    Status App 25

4 Calling & Contacts 26
  Phonebooks 26
    Creating Phonebook Entries 26
      System Extension Entries 27
        Phonebook 27
        Extension(s) 27
      Permission Type 27
        Normal 27
        Extended 27
      External Number Entries 27
        Phonebook 27
        Number 27
        Name 27
        Jabber ID 27
      Status Indicator Entries 27
        Phonebook 27
        Entry Name 28
        Monitor Type 28
      Switchvox-Peer Entries 28
        Peer Extension Phonebook Option 28
        Number 28
        Peer Entry Name 28
        Peer Entry JabberID 28
Phone Features Options 28
Additional Numbers 29
Contacts App 29
Queues App 29
Conferencing 30
General Settings 30
	Your Conference Room Number 30
	Play sound when people enter/leave 30
	Play Music On Hold when only 1 member is in the conference room 30
	Conference members may press # and be sent to extension [] 30
Conference Admins 30
Admin Settings 31
	Only allow conference admins to talk 31
	Hang up conference when all conference admins leave 31
	Users cannot talk until a conference admin is in the conference room 31
Digium Phone Calling Features 31
Dialing Calls 31
Receiving Calls 31
Redial 31
Hold 31
Transfer 32
	Assisted. 32
	Unassisted (blind). 32
Transfer to Voicemail 32
Park 32
Record 32
Three-way Conference 32

5 Voicemail & FAX 33
Greetings 33
Notifications 33
Voicemail Notifications 33
Notification Templates 34
Fax Notifications 34
Mailbox 34
Voicemail 34
	Delete Local Copy 35
	Forwarding 35
Faxes 35
	Fax Options 36
	Sending and Receiving 36
	Treat All Outgoing Calls as Faxes 36
Print a fax-file 36
Fax Header 37
Digium Phone Voicemail App 37
The Voicemail System 37
Putting the Mailbox on Your Desktop 38
Subscribing to Folders 39

6 Faxing 40
Setting Up a FAX Printer 40
Sending a Fax 40

7 Reporting 42
Call Logs 42
Call Reports 42

8 Switchboard 44
Using the Switchboard 44
Options 44
Save Layout 44
Panels 45
My Phone 45
Switchboard Panels 45
Current Calls 45
Send Call 45
Hold & Resume 45
Take Another Call 45
Transfer: Assisted & Blind 45
Transfer to Voicemail 45
Record 45
Directory 46
Parking Lot 46
Profile 46
Chat 46
Call 46
Voicemail 46
Phonebook 46
Normal Entries 46
Extended Entries 47
Status 47
Intercom 47
Pickup 47
Record 47
Monitor 47
Barge 47
Whisper 47
Chat 48
Queue 48
Overview

Typically, everyone in your organization has been assigned an extension associated with a Digium Phone and the Switchvox system. These extensions are the numbers Switchvox uses to send calls to various destinations.

This guide gives extension owners basic how-to information so they can quickly get acquainted with and effectively use their Digium Phones and the Switchvox system to communicate in a business environment.

This guide steps you through the following basic features of the Switchvox Extension Tool Suite (the Extension Suite) as well as apps from the Digium Phone and features of the Switchvox graphical interface called the Switchboard:

- Setup
- Call Rules & Status
- Calling & Contacts
- Voicemail & FAX
- Faxing
- Reporting
- Switchboard

The Switchvox Web Tool Suite (Admin and Extension) is the primary means of managing the Switchvox system and your phone. You can access the tool suite from any computer on your network via a web browser. The URL can be found on the Welcome to the Digium IP Phone sheet/card that came with your phone.

Refer to the Support page of the Digium website (http://www.digium.com/en/support-center/) for additional documentation and other technical support information.
2

Setup

The Extension Suite lets you customize your extension’s features. It is accessed by clicking the login icon for your extension number from Extensions > Manage, in the Switchvox Admin Web Tool Suite (the Admin Suite) or logging in directly to the Extension Suite using your extension number and a numeric password. (See your Welcome to Digium IP Phone card for the URL to use to access these web suites.)

The following basic setup options are described in this section:

- My Account
- Additional Numbers
- Phone Features
- Converged Phones

My Account

My Account lists the Profile Information associated with your Switchvox extension. After logging into the Extension Suite with your extension, go to

Features > Account > My Account

This displays the My Account page for your extension. If your administrator has given you permission to change your profile information, you can change it from this page. This includes editing your voicemail/web suite password, name, email address, title, language setting, and other things.

When finished making changes, click Save Account Information, and the system displays:

Successfully modified your account.

Voicemail and Web Suite Password

- To make a new password, enter a minimum of three numbers in the Numeric Password text box. The strength of the password is indicated as you enter it to help you create the most secure password.
- For verification, enter it again in the Retype Numeric Password text box.
- Click Save Account Information to save the new password. The page is refreshed, and a message indicates your changes were saved.
**IMPORTANT:** This changes the password for both your voicemail and Extension Suite access.

### Language Setting

The Extension Suite is available in several languages. If you wish to change the language, select one of the following from the dropdown:

- English for United States
- English for United Kingdom
- Spanish for Spain
- Spanish for Mexico
- Italian

**NOTE:** All Language Settings except English for United States use the following format for dates:

`dd/mm/yyyy`

This means 30/11/2011 denotes November 11, 2011.

### Sound Prompt Language

If there are one or more sound packs available in different languages for your phone, you can select a language from this dropdown. The language selected will be what your extension hears. For example, if you select Italian, then call the voicemail access extension, all prompts will be in Italian.

### Profile Picture

To add a picture to your profile, click **Upload Picture** and follow these steps:

- Click inside the text box to open a dialog box and find the image file on your computer.
  **NOTE:** The Images must be at least 75x100 pixels and be in jpg format.
- Click **Upload**. The image is uploaded and displayed with the crop area that will be used to make a 75x100 image. You can move the crop area around to choose the best portion of the picture. The Preview on the right shows you what the picture will look like after it is cropped.
- Click **Upload Picture**.
- If you want to re-crop or delete a picture, click **ReCrop** or **Delete**.
- If you want to upload a different image, delete the already uploaded image, then click **Upload Picture** to start again. Confirm your changes.
Additional Numbers

The Additional Numbers option associates other numbers and extensions to your profile and account. This is useful for helping others in your organization find you when you are away from your desk. For example, you can add your mobile phone number, your home phone number, or even another extension that you use frequently.

IMPORTANT: If you have another phone numbers that you use often, you may want to add those numbers to your Converged Phones, rather than making it an Additional Number.

To create an additional number, go to Features > Account > Additional Numbers.

- Click Create Additional Number.
- Select an icon for the additional number (for example, mobile, home, etc.).
- Enter a name (title) for it.
- Enter the phone number or extension.

NOTE: The number, icon, and title are displayed in your Phonebook entries of your coworkers.

- To change the icon for an entry, click its change icon.

IMPORTANT: Enter the number as you would dial it from your phone. For example, begin the number with a 9 or an area code if that is how you normally dial that number from your phone.

- Click the pencil icon to modify a number.
- Click the red X to delete a number.
- Use the green arrows to change the order in which your numbers are displayed.

Phone Features

The Phone Features option allows you to customize the way your Digium Phone works.

IMPORTANT: If you make changes to any of these settings, your phone will be reconfigured.

To make changes to your Digium Phone Settings, go to Features > Phone Features > Phone Settings > Digium Phones

This displays the page from which you can make any of the following changes:
General Settings

**Line Label.** This sets the label displayed on the phone's Line Key for this extension.

- Enter a specific label, or use variables to describe the label. Variables are useful in Extension Templates so you do not have to set a unique label for each extension.

Msgs Button

**Msgs Button Action.** This sets what the phone does when its **Msgs** button is pressed:

- Select **Open Visual Voicemail** from the dropdown to use the phone Voicemail application to navigate via the phone display.
- Select **Dial Voicemail Extension** to call the voicemail system extension and navigate via sound prompts.

If you select Dial Voicemail Extension, you can either enter an **Extension** or search for and select an **Extension.** The default Voicemail extension number is 899. See **Voicemail & FAX** for more about Voicemail.

Idle Screen

**Idle Screen Image.** This changes the image that displays on the phone's idle screen.

- Click the **Upload** icon. This displays a popup from which you can search for an image on your computer and upload it or cancel it.
- Click **YES** for **Display Missed Calls Notification** to display a notification in the top-left corner of your phone’s idle screen.

Display

**Brightness and Contrast.** Use the sliding control to adjust the brightness and contrast in your phone’s display.

**Backlight Dimming.**

- Click **YES** to dim the backlight after the phone is not in use.
- Enter the number of seconds before dimming in the **Seconds until Backlight Dim** text box.
- Use the sliding control to select the Backlight Dim Level. Level must be less than the brightness.

Sounds

**Default Ringtone.** Select the default ring tone used for incoming calls from the drop-down. (unless you have set up one or more **Ring Rules**).

**Reset Volume Every Call.** The volume can be changed during a call, using the volume control bar on the phone. Select **YES,** to reset the volume to the default after each call.

Answering

**Headset Answer.** Select **YES** to use the headset, not the speaker, when you press the **Answer** softkey during an incoming call.

**Auto-answer Switchboard initiated calls.** Select **YES** to set your phone to automatically answer Switchboard-initiated calls. If **NO,** when you click on a Switchboard **Phone-**
book entry, your phone rings and you have to pick it up, then Switchvox dials the number for that entry.

After making any changes, click Save Phone Settings.

**Ringtones**

Switchvox can store and play ringtones that can be used on your Digium phone. Although there are limitations for the total number of ringtones and the total amount of disk-space that can be used, you should have plenty of room to add the ringtones you like.

To view the existing ringtones or create a new ringtone, go to

**Features > Phone Features > Ringtones**

This displays the Ringtones Page, which lists both preloaded and uploaded ringtones. If you have added ringtones directly to your phone, they are not included in this list.

**Creating a Ringtone**

- To create a ringtone, click Create Ringtone. This displays the Upload Ringtone popup.
- On the popup, click in the Choose a File box to browse your computer to find a .WAV sound file.
- Enter a name for the ringtone in the Ringtone field.
- Click Save Ringtone. The Ringtones list is refreshed, with your new ringtone listed.

**Distinctive Ringtones**

Depending on the permissions you have for each ringtone, you can do the following to a ringtone that is displayed in this list:

- Play the ringtone. The audio file is downloaded to your computer, then played using your default audio player for WAV files.
- Modify the ringtone if it is not a preloaded file. You can upload a new file, or change the Name.
- Delete the ringtone if it is not a preloaded file. You must verify that you want the ringtone deleted.

**NOTE**: If you delete a ringtone, every Ring Rule that uses that ringtone is also deleted.
Ring Rules

Ring Rules define conditions for callers or kinds of calls and what the phone does when those calls come in.

To create a ring rule, go to

Features > Phone Features > Ring Rules

This displays the Ring Rules page.

Ring Settings

Click Create Ring Rule to display the Ringing Settings popup.

- Enter a Rule Name.
- Select the Ring Type (that is, the action your phone should take) from the dropdown. Options are Standard Ring, Auto Answer, Ring, then Auto Answer, or Visual Indication.
- If you have chosen a Ring action, select a Ringtone to associate with it from the dropdown.
- Click Save Ringtone Rule.

The new rule is now displayed on the Ring Rules page, and you must create the Ring Rule Conditions for it.

- Select the Call Type from the dropdown. The following are options:
  - Direct Calls. If the incoming call was made directly to your extension (or to a DID that is directly routed to your extension), the condition is met.
  - Queue Calls. If the incoming call comes from any queue, the condition is met.
  - Internal Calls. If the incoming call originated in Switchvox, the condition is met.
  - External Calls. If the incoming call originated outside of Switchvox, the condition is met.
  - All Calls. All calls coming into your extension.
- Click Save the Condition.
- Then choose a type. The following are options:
  - Extension. Enter one or more extensions the condition applies to. If the incoming call is from any one of these extensions, the condition is met.
  - Caller ID. Enter a number range for the caller ID the condition applies to. If the incoming caller ID is equal to one of these numbers, or it falls between them, the condition is met.
  - Number Pattern. Enter a number pattern the condition applies to. Use the asterisk (*) to indicate that any number matches. For example, 619555* matches every call with area code 619 and prefix 555. If the incoming caller ID number matches the number pattern, the condition is met.
  - Name Pattern. Enter a name pattern the condition applies to. Use the asterisk (*) to indicate that any letter matches. For example, *Smith matches every call from a name that ends with Smith. If the incoming caller ID name matches this text pattern, the condition is met.
**Ring Hint.** Ring Hints are created and managed by your Switchvox administrator. They can indicate almost anything, so check with your administrator before using this condition. If the incoming call has the Ring Hint associated with it, the condition is met.

- After you have created the conditions, click **Save**.
- Restart your phone.

After you have set up Ring Rules and restarted your phone, your ringtone disk space usage is displayed. This is specific to your phone and can help you decide which ringtones to use for your Ring Rules.

### Changing a Ring Rule or Condition

To change existing Ring Rules or Conditions do the following:

- Click the **Modify** icon (pencil) to change the settings of a rule, or of one condition in a rule, then click **Save**.
- Click the **Delete** icon (X) to delete a Ring Rule, or to delete one condition in a rule.

### Converged Phones

The **Converged Phones** option allows you to join other Switchvox extensions and phones to your main extension so they appear to be your main extension. For example, you can converge your Switchvox extension at home and your mobile phone with your main extension on your desk so all three appear as the extension on your desk.

Many things happen when you converge a phone with your main phone:

- Your Switchvox voicemail messages and faxes all go to your main phone’s Switchvox mailbox.
- Your Caller ID is always that of your main phone, as long as the call originates from Switchvox. That means calls from your Switchvox extensions, or a Switchvox App such as Switchvox Mobile or Switchvox Notifier.
- Your call logs are included in your main phone's call logs.
- In your Switchvox Switchboard, your Current Calls panel includes the current calls for the Converged Phone. You can act on those calls as you normally do. (See the **Switchboard** section for a discussion of Switchboard panels.)
- In your Switchboard, you can specify which of your Converged Phones you want to use. That way, when you click-to-call, the correct phone rings.
- In another person's Switchboard, you appear busy on your main phone if you are on a call with any Converged Phone. With the correct permissions, your call information is visible and it can be recorded, monitored, whispered, or barged into.
- In The InCall Menu, you can easily transfer calls between your Converged Phones.

On a Digium Phone, if line 1 is a converged phone (not a Main Phone):
• The main extension is used for all voicemail activity: message indicator light, the Msgs button, and dialing the voicemail system extension.
• The main extension is used for these Apps: Contacts, Status, Queues.
• The main extension is used for parking a call (the call appears to be parked by the main extension).
• The main extension is used to log into and out of a queue via a Status Indicator Rapid Dial Key. (See also: See "Status Indicator Entries")

Things to consider when you converge phones:
• You probably want to adjust the Call Rules for your main phone and any converged Switchvox extensions, so that incoming calls ring your phones appropriately.
• Most of the time, you should log into the Switchvox Extension Suite for your main phone. The only time you should need to log into the Extension Suite for a converged phone is to set up specific Call Rules or Phone Features.
• You can have as many as 6 Converged Phones, including your main phone.

Use the Extension Suite to set up specific **Call Rules** or **Phone Features** for your main phone and any converged Switchvox extensions so incoming calls ring your phones appropriately.

**Managing a Converged Phone**

To create and authorize a Converged Phone, log into your main extension.

• Go to **Features > Converged Phones**.
• Click **Add Converged Phone**.
• Select the External Number tab to create a Converged Phone that is not part of Switchvox.
• Or select the Extension tab to create a Converged Phone that is another Switchvox extension.
• Enter the number, and set the options as appropriate (see the Options section below).
• Click **Create**. The new phone is saved and is now in the list of Converged Phones.
• Verify that you can answer that phone, then click **Authorize**. An Authorization Code is displayed.
• When that phone rings, answer it. Enter the Authorization Code on your phone's keypad.
• If prompted, enter the password for the Switchvox extension you are converging.

To modify a Converged Phone,

• Click the **Modify icon** for the phone.
• Make your changes.
• Click **Update Converged Phone**.
To Delete a Converged Phone,

- Click the **Delete icon** for the phone.
- Verify you do in fact want to delete it.
- Click **Yes, Delete**.

**NOTE**: Numbers displayed in your Converged Phones list cannot be converged with another Switchvox extension. That applies to Switchvox extensions or to external phones. To add a converged phone from your list to someone else's Converged Phones, you must first delete it from your Converged Phones list.

**Options**

Each of your Converged Phones has a label and is available as a Rapid Transfer option in the InCall Menu. Rapid Transfer is “speed dial” for your InCall Menu. Enter or select the appropriate information as described in the following:

**Acknowledge Rapid Transfer.** Select **Yes** or **No**.

If **YES**, when you use the Rapid Transfer option from the InCall Menu, Switchvox does not transfer the call until you have answered and acknowledged it by pressing ONE on your keypad.

If **NO**, Switchvox completes the Rapid Transfer as soon as the call is answered.

**Label.** Enter a label (name) for this Converged Phone, for easy reference.

**Rapid Transfer Key.** Select a line key number from the dropdown to press on your phone's keypad to complete a transfer.

**Rapid Transfer Sound.** Select a sound from the dropdown to play in the InCall Menu to describe this Rapid Transfer option.

Click **Save Converged Phone** when finished.

**InCall Menu**

The **InCall Menu** lets you easily transfer or record a call from any of your Converged Phones. Actually, the InCall Menu works from any Switchvox extension, but your Converged Phones have extra Rapid Transfer options for quick transfers to the phones you use often.

To access the InCall Menu during a call, press ** on your phone's keypad. When you press **, the InCall Menu answers and its audio prompts help you decide what to do.

Although you are the only one who hears the InCall Menu (your caller does not hear it), your caller may hear the tones from your key presses. It depends on how your call is being routed, over analog lines or over particular VoIP providers.
The following describes the InCall Menu options for a person who has 3 Converged Phones: a main extension, a mobile phone, and a home phone.

**Main Menu: Rapid Transfer**

The main activity for the InCall Menu is to transfer a call to one of your Converged Phones.

In the main menu, each of your Rapid Transfer numbers is offered, one at a time, from one through six:

To transfer to your main phone **press 1**.

To transfer to your mobile phone **press 2**.

(and so on...)

To exit this voice menu and return to your call **press the star key** (*).

For more options **press the pound key** (#), also called the hash key.

If you press a Rapid Transfer number, Switchvox rings the phone number for that Rapid Transfer option. When that phone is answered, the call is transferred. If that Converged Phone is set to Acknowledge Rapid Transfer, then you must acknowledge the call to complete the transfer. (For details, see **Converged Phones**.)

**Options Menu: Transfer and Recording**

From the main menu, if you chose more options by pressing the # key (**#**):

- To perform a transfer, **press 1**. Your call is put on hold, and the Transfer options continue (see below).
- To transfer this call to your voicemail, **press 2**. Hang up the phone and your call will be transferred to your voicemail box.
- To start/stop recording this call, **press 3**. The beep indicates recording has started, or recording has stopped.

To exit this menu, **press the star key** (*).

**Transfer Menu**

From the options menu, if you chose to perform a transfer by pressing one (**#1**):

- To perform an assisted transfer, **press 1**.
- Enter the extension you want to call. If you need to use the Directory to find an extension number, use assisted transfer and call the Directory.
- Confirm with that person you are going to transfer the call.
- **Press **2 to perform the transfer, or **press **2 to cancel the transfer.
- To perform a blind transfer, **press 2**. Enter the extension you want your call transferred to.

To exit this menu, **press the star key** (*).
Call Rules & Status

Call Rules tell Switchvox what to do when a call comes to your extension. Based on the time and day, you can ring several phones, forward the call somewhere else, send the call straight to your voicemail, etc. If you use multiple phones, you might also want to converge the other phones, so that if you answer any of your phones, your presence shows busy.

The following are the call rule and status options described in this section:

- Call Rules
- Time Frames
- Status Options & Status App

Call Rules

To set up your Call Rules, go to the Extension Suite, Features > Call Rules. This displays the Call Rules page, which is divided into four tabs:

- Unanswered Call
- Busy Call
- Call Blocking
- Messages/Prompts

The Call Rules page lists all of the rules you have created. You can disable, activate, modify, or delete each rule by clicking its appropriate icon (shown under Actions).

Switchvox also displays the already defined rules under each tab. The rules are executed in order. Use the green arrows to prioritize the list.

The following sections describe the Call Rules tabs.

Unanswered Call

Unanswered Call (displayed by default) is the rule set in which you define actions that happen when your extension receives a call that is not answered.

Unanswered call rule sets can involve immediate action or action after a defined number of rings. The default call rule sends a call to your voicemail after 5 rings.

Each call rule set can include Time Frames during which the rule is valid. In that way, Switchvox can handle calls according to the time of day the call is received; for
example, during business hours, in the middle of the night, or any other Time Frame you define.

Switchvox evaluates each of your Active Call Rules in the order they are listed and applies the rule when the call meets the rule criteria.

IMPORTANT: You should always test your rules by calling your extension from another phone before activating the rule.

Creating a Call Rule Set

Click **Create Call Rule Set**. This displays a General Settings popup.

- Enter the **Rule Set Name**.
- Select the **Rule Set Time Frame** (when the rule set should be used) from the dropdown. Switchvox will evaluate the current date and time against this time frame, and if they match then the rule is followed. If they do not match, Switchvox moves on to the next rule. See **Time Frames** for more information.
- Select the **Rule Set Presence** (what your current status is set as) from the dropdown.
- Click **Save Call Rule Set**. This saves the rule set, displaying a confirmation message and the Action tab/page.

Creating Call Rule Actions for a Set

- Click **Create Action** to associate an action with the rule. This displays a popup menu with types of actions.
- Choose a type from the list. Options and their respective popup menus include the following:
  - **Send to Voicemail**. This sends the call to your voicemail so the caller can leave a message. Enter the following information:
    - **Type of Call**. Specify whether the rule applies to direct calls, queue calls, or all calls.
    - **Number of times to ring**. Enter the number of times to ring your phone before initiating this action.
  - **Call Forward**. This forwards the call to another Switchvox extension. The extension can be another phone, a call queue, or any other type of extension. After a call is forwarded to the extension, the call rules for that extension are followed. Enter the following information:
    - **Type of Call**. Specify whether the rule applies to direct calls, queue calls, or all calls.
    - **Extension to Forward to**. Enter a Switchvox extension.
    - **Number of times to ring**. Enter the number of times to ring your phone before initiating this action.
  - **Call Cascade**. This action rings another extension or an external phone number (i.e., your mobile phone). If the call isn’t answered, then it is passed on to the next action. This action depends on your Outgoing Call Provider: if your provider supports it, you can stack several rules to try and reach you at several phone numbers. Enter the following information:
Call Rules

— **Type of Call.** Specify whether the rule applies to direct calls, queue calls, or all calls.

— **Number to forward to.** A Switchvox extension, or an external number. If this is an external phone number, enter the number as you would dial it, including a ‘9’ or other necessary digits.

— **Number of times to ring.** Enter the number of times to ring your phone before initiating this action.

— **Attempt to preserve Caller ID.** YES indicates that Switchvox should try to send the originating caller ID when it rings the number. This is not always possible, depending on the provider, but it will be attempted.

— **Acknowledge call.** YES indicates that you want to acknowledge (accept) the call before Switchvox completes the call. Switchvox does not complete the call until you have answered it and acknowledged it by pressing ONE on your keypad. So, if the action rings this number and it is answered but not acknowledged, Switchvox continues to follow your Call Rules. This protects calls from being answered by unauthorized individuals (like kids, or very smart dogs!).

  **NOTE.** Acknowledge Call is useful if you might not be the person answering the phone number. It can also ensure that your calls end up in your Switchvox voicemail (as opposed to your voicemail at home, or on your mobile).

• **Secret Code.** This action prompts the caller to enter a secret code, then passes the caller to the next action. If the caller cannot enter the correct secret code after the specified number of tries, then you can specify what to do with the call. Enter the following information:

  — **Type of Call.** Specify whether the rule applies to direct calls, queue calls, or all calls.

  — **Secret Code to prompt for.** Enter one to 7 characters (0-9, *, or #).

  — **Number of times to ring.** Enter the number of times to ring your phone before initiating this action.

  — **Number of tries to allow.** Enter the number of times the caller can try to enter your secret code. After this number of tries, the following action happens:

    — **If code is incorrect, then**
      
      Play Busy Signal
      Play Congestion
      Hang Up
      Send to Voicemail

• **Ring All.** This rule simultaneously rings up to 3 extensions or external phone numbers.

  **IMPORTANT:** A Ring All action must include your main extension if you want that phone to ring.

If you need to ring more than 3 phones, you may set up subsequent Ring All actions that ring those additional phones. In this case, the first set of phones ring, and then the second set of phones ring. Enter the following information:
— **Type of Call.** Specify whether the rule applies to direct calls, queue calls, or all calls.

— **Numbers to Ring.** Enter the Switchvox extension or an external phone number. Enter the number then click Add.

    **NOTE:** If you are ringing an external phone number, be sure to add a ‘9’ or other necessary digits that you normally use to dial out.

— **Acknowledge Call.** Each number in the list can be set to complete the call without an acknowledgement or with it. To change that, select the number and turn Acknowledge Call on or off.

Switchvox does not complete the call until you have answered it and acknowledged it by pressing ONE on your keypad. So, if the action rings this number and it is answered but not acknowledged, Switchvox continues to follow your Call Rules. This protects calls from being answered by unauthorized individuals (like kids, or very smart dogs!).

— **Number of times to ring.** Enter the number of times to ring your phone before initiating this action.

— **Attempt to preserve Caller ID.** YES indicates that Switchvox should try to send the originating caller ID when it rings the number. This is not always possible, depending on the provider, but it will be attempted.

• **Decline.** Enter the following information:

    — **Type of call.** Select from dropdown.

    — **Number of times to ring previous rule before declining or starting silent rings.** Select from dropdown.

    — **Number of rings to play direct callers.** These are silent rings. Note that queue calls are instantly declined and do not have silent rings.

• When finished defining the action, click **Save Action**.

• If you want to associate more actions with the rule, click **Create Action** again and go through the process for each additional action.

---

**Prioritizing Actions in a Call Rule Set**

Switchvox executes actions in your Call Rules in top-to-bottom order.

• To prioritize actions, use the arrows to the left of the list to move actions up or down.

• When finished, click **Back to Call Rules**.

---

**Modifying a Call Rule**

• From the Call Rules page, click the **Modify** icon for the rule for which you wish to make changes. This displays the Actions page with the list of action types associated with the rule. Each action type can either be modified or deleted, or you can add a new action to the rule set.

• Click the appropriate icon and make the necessary additions or corrections.

• Click **Save Action** when finished.
### Activating a Call Rule Set

Click its **Activate** button, and specify how long the rule is to be active:

- A duration of time that begins immediately and runs as long as indicated.
- A date on which the rule deactivates. At 12:00 AM on that date, the rule is deactivated.

You can see the Active state of the rule set in the Call Rule Sets list:

### Busy Call

Busy Call Rule Sets specify how a call is handled when you are on the phone (your line is busy).

- To create Busy Call Rule Sets, set **Use Unanswered Call Rule Sets** to NO. That makes the Create Call Rule Set button active, so you can click it to create a Busy call rule set.

Busy Call Rule Sets use the same settings and actions as **Unanswered Call** Rule Sets.

### Call Blocking

Switchvox lets you specify phone numbers you do not want to accept calls from. You can block specific phone numbers, or any numbers that begin with the same prefix, and you can block them at all times or during specified time frames. You can also choose how Switchvox handles the blocked calls.

#### Creating a Call Block Rule

- Click **Create Call Block Rule**.
- Select Phone Number or Prefix from the dropdown.

**IMPORTANT**: Be careful using Prefix. If you put in the wrong prefix, you may block more calls than you expect.

- Enter the number to block.
- Select the action Switchvox should take with the blocked call.
- Select **Time Frames**, if you want to control when these calls are blocked.
- Click **Save** to save your changes.

### Messages/Prompts

These sound prompts are used in your Call Rules Secret Code actions. You can change the prompts by recording your own sound over your phone, or by uploading a new sound file.

- To create or modify your own sound, click the prompt’s **New** button.
- To play the sound, click the prompt’s **Play** button.
- To remove a sound that you created and go back to the default sound, click the prompt’s **Use Default** button.
## Time Frames

Switchvox can operate differently based on the date, day, and time by defining and associating Time Frames to rules.

A **Time Frame** is considered valid when the current date and time match any one of a Time Frame’s conditions. Not all of the rules have to match.

### Managing Time Frames

Time frames consist of Time Frame Conditions. The time frame itself is considered valid when any of its conditions are met.

To modify a **Time Frame** with Conditions:

- Click **Create Time Frame Conditions**.
- Enter a Date Range, Day of the Week Range, or a Time Range, or any combination.

Continue adding conditions until you have completed the Time Frame definition.

The following are sample time frame definitions:

**• Mondays 12:00am to 11:59pm, and Wednesdays 12:00am to 11:59pm**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Start Day</th>
<th>End Day</th>
<th>Start Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>Monday</td>
<td>Monday</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>Wednesday</td>
<td>Wednesday</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

**• Early Morning**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Start Day</th>
<th>End Day</th>
<th>Start Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>3:00am</td>
<td>6:00am</td>
</tr>
</tbody>
</table>

**• The First Week in July 2011**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/01/2011</td>
<td>07/07/2011</td>
</tr>
</tbody>
</table>

**• Weekdays in February, 2011 between 6:00 and 7:00 in the morning.**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Start Day</th>
<th>End Day</th>
<th>Start Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/01/2011</td>
<td>02/28/2011</td>
<td>Monday</td>
<td>Friday</td>
<td>6:00am</td>
<td>7:00am</td>
</tr>
</tbody>
</table>

**• After January 21, 2011**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Start Day</th>
<th>End Day</th>
<th>Start Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/21/2011</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
Modifying a Time Frame

• To change a time frame, click its Modify button. This displays the Modify Time Frame page. You can create a new condition, or delete any conditions that you do not want to include in this time frame. You cannot modify a condition.

Deleting a Time Frame

• To delete a time frame, click its Delete button. Be sure that you do indeed want to delete this time frame, then click Yes, Delete Time Frame. The Time Frames main page is deleted with a message that the time frame was deleted. IMPORTANT: Before you delete a Time Frame, be sure you do not have any IVR Menus or Call Rules that depend on it.

Status Options & Status App

Your personal Status Options are created under one of the main Status types: Available, Away, Prefer Chat, Extended, Away, or Do Not Disturb. These Status Options are available to set from the Switchvox web interface or from your Digium Phone Status Ap.

Status App

Press the Status button or softkey to change your status. Do Not Disturb sends incoming calls to your voicemail and declines queue calls. Your coworkers see your Status on their phones or Switchboards. You can use Call Rules to manage incoming calls based on different Status Options.
Phonebooks

The Switchvox Phonebook feature lets you organize both internal and external contacts so you can easily access extensions and numbers from your Switchboard and your Digium Phone.

To create a Phonebook,

• Click Create Phonebook.
• Enter a unique name for the Phonebook.
• Click Save.

The Phonebook is created and is now available for new entries.

• To move an entry back and forth as a Normal or Extended entry, drag the entry’s green arrow icon.
• To delete an entry, click its Delete button. You are asked to verify the deletion request. Click Yes, Delete. The Phonebook is refreshed, and this entry is gone.
• To delete a Phonebook, click its X icon. You are asked to verify the deletion request. Click Yes, Delete.

NOTE: You cannot delete the Default Phonebook.

Creating Phonebook Entries

There are different types of Phonebook entries, depending on whether it is a Switchvox extension, or is an external phone number.
### System Extension Entries

System Extension Entries are other Switchvox extensions. You can add user-type extensions, and other types of extensions such as queues or IVRs.

- **Phonebook.** Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

- **Extension(s).** Enter at least one extension here. To enter multiple extensions, put a comma (,) after each extension. Click the people icon to see a directory of your Switchvox extensions. Hold down Ctrl to select many extensions, or hold down Shift.

### Permission Type

- **Normal.** Shows the user’s Presence, and whether or not he or she is on the phone. Also includes a dropdown that lets you open a chat, call additional numbers, or Intercom the person.

- **Extended.** Shows the Normal features, plus the caller ID name and number of the user’s active calls. It also includes options to monitor, record, whisper, barge into, or pick up the user’s calls.

Only phone-type extensions can be Extended Permission entries. If you try to add any other type of extension (e.g., a Call Queue), it is added as a Normal entry.

You can change an entry’s permission type at any time.

If you cannot see or use an option in an Extended Entry, your Switchvox administrator has not given you permission to do so.

### External Number Entries

External Number Entries are for names and phone numbers other than Switchvox extensions. Once you add an external entry, you will also be able to put Additional Numbers into that entry.

Make sure to enter this number as you would dial it from your phone. For example, if you must dial 9 for an external number, an external number here must begin with a 9.

- **Phonebook.** Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

- **Number.** Enter the phone number.

- **Name.** Enter a name.

- **Jabber ID.** Enter this person’s Jabber ID to display his Jabber presence on your Switchboard in his Phonebook entry.

  The Jabber ID has a user ID (the extension) and a Jabber Hostname. For example, 101@jabber.peeredswitchvox.com.

### Status Indicator Entries

A Status Indicator entry controls a line status indicator light on your phone.

- **Phonebook.** Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.
**Phonebooks**

**IMPORTANT**: This must be the same Phonebook as the one in the Phone Features Options for this entry to affect your phone. Also, it must be one of the first entries in the Phonebook if you want it to display without having to scroll through the entries on your phone.

**Entry Name**
Enter a name for this entry. This isn’t required, as you don’t see the entry in your Switchboard.

**Monitor Type**
- Parking Lot: This lights up the line status indicator on your phone when a caller is waiting in the specified Parking Lot Extension.
- Queue Login Status: This lights up the line status indicator on your phone when you are logged into the specified queue. Enter the Agent Login Extension that you use to log into this queue, and the queue that you want to monitor.

<table>
<thead>
<tr>
<th><strong>Switchvox-Peer Entries</strong></th>
<th>If your Switchvox is peered with another Switchvox, you can include the peered Switchvox extensions in your Phonebook. For peered extensions, use the External Number entry type (because this extension is not on your Switchvox).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Peer Extension Phonebook Option</strong></td>
<td>Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.</td>
</tr>
<tr>
<td><strong>Number</strong></td>
<td>Enter the extension number from the peered Switchvox, just as you would dial it on your phone. Peered extensions might start with a different number than yours, or have more digits.</td>
</tr>
<tr>
<td><strong>Peer Entry Name</strong></td>
<td>Enter a name for this entry.</td>
</tr>
<tr>
<td><strong>Peer Entry JabberID</strong></td>
<td>Enter this person’s Jabber ID to display his Jabber presence on your Switchboard in his Phonebook entry. The Jabber ID has a user ID (the extension) and a Jabber Hostname. For example, <a href="mailto:101@jabber.peeredswitchvox.com">101@jabber.peeredswitchvox.com</a>.</td>
</tr>
</tbody>
</table>

**Phone Features Options**
The Phone Features Options let you specify a Phonebook to push out to your phone.

When you make changes to a Phonebook, or you want to change the Phonebook that is already on your phone, click **Reboot Phone** to send the correct Phonebook out to your phone. Rebooting your phone takes a few minutes, and you will not be able to make or receive calls while it is rebooting.

**NOTE**: If the phone is not on the same network as Switchvox, the phone might not be rebooted. In that case, you must reboot the phone manually.
**Additional Numbers**

Each Phonebook entry is based on one main extension or phone number, but it can have also have additional numbers associated with it. This way, you can have one Phonebook entry for a person, and have all of their contact numbers included in that entry.

Each entry's Additional Numbers are available from the View Additional Numbers icon for the entry.

Additional Numbers may have been created by an extension owner, or you can create them in your Phonebook entry.

Additional Numbers entered by an extension owner are available when you add the extension to your Phonebook. These numbers appear as locked and cannot be edited, but you can choose to hide them in the Switchboard.

Additional numbers that you add to your Phonebook entry can be edited and deleted.

You can also copy any Additional Numbers (including the owner’s numbers), and then edit or delete the copy.

---

**Contacts App**

Contacts include all of the contacts from your Switchvox administrator and the contacts you actually put in your phonebooks. Contacts are used for rapid dialing and for finding detailed information about someone. You can use Contact from within Transfer, Conference, and Forward voicemail on your Digium Phone.

To see the Detail page for a contact, press the Show softkey in a list of contacts. Details include the person’s Status.

Your contacts can also define your unused Line Keys and Rapid Dial Keys. See the Phonebooks section for more on this.

---

**Queues App**

Use the Queue App to log into and out of call queues and to see queue details. Press the More...> Queue softkeys. Switchvox then fetches the Call Queues you have permission to view.
Conferencing

Ask your Switchvox Administrator for the main conference room extension number. When a caller dials that number, he or she can access your conference room by dialing your conference room number, then the pound key (#). See Three-way Conference for description of the Digium Phone conferencing feature.

General Settings

You can change the behavior of your conference room using several options.

Your Conference Room Number: Enter a unique 5-digit number for your conference room. This is the number that you give to callers so they can access your conference room. Click the green arrow to have the system pick a random, unused room number for you.

Play sound when people enter/leave. YES indicates that the following sound type is played to all members of the conference room when a new caller enters the room. There are three options for the sound type that is played when a caller enters and exits your conference room:

- Only Sound: Only a sound is played, no information about the caller.
- Sound with Caller Name: The caller is prompted to record his or her name. The recorded name is then played along with a sound.
- Sound with Caller Name (user review option): This is the same as Sound with Caller Name, but it gives the caller an opportunity to listen to the recorded name, then accept or re-record it before joining the conference room.

Play Music On Hold when only 1 member is in the conference room. YES indicates this is true.

Conference members may press # and be sent to extension [ ]. Enter an extension here, so that when a member presses the # key, they are transferred to that extension.

Conference Admins

Conference Admins are special members of your conference room who have specific privileges.

This collector box lets you find and collect extensions and/or Extension Groups that have Admin privileges for your conference.

Type a name or extension number into the text field. As you type, Switchvox offers suggestions of matching extensions.

Click the Find icon to display the extensions available in Switchvox. You can sort this view by the column headers. If you are working with phone-type extensions, you can expand the window to show an extension owner’s profile.

To delete an item from the collection, select it and click the Delete icon.
To select multiple items in the collection:

- Control-click to select two or more items that aren't together in order.
- Click an item, and then Shift-click another item to select both items and all items between them.

**Admin Settings**

The Admin Settings control what happens in a conference based on whether or not an Admin is present.

*Only allow conference admins to talk.* YES indicates that all non-admin callers can only listen, they cannot be heard in the conference room.

*Hang up conference when all conference admins leave.* YES indicates that your conference room hangs up if there are no admins in the call.

*Users cannot talk until a conference admin is in the conference room.* YES indicates that no one can be heard in the conference room until an admin is in the room. Callers can join the room, but they cannot speak to each other.

**Digium Phone Calling Features**

The following summarize how to use common calling features of your Digium Phone.

**Dialing Calls**

Pick up the handset, or press a line key and dial a number. Or dial a number and press the **Dial** softkey. You can also use **Contacts** or **Call Log** to find a number, then press the **Dial** softkey. If you use Contacts, you can dial a coworker’s Voicemail.

**Receiving Calls**

Pick up the handset, or press a softkey: **Answer**, **Ignore**, **Transfer**, or **Send VM**.

- **Ignore** makes the call stop ringing but uses your Call Rules.
- **Transfer** lets you transfer the call.
- **Send VM** sends the call to your voicemail regardless of your Call Rules.

**Redial**

Press the **Redial** button to redial the last call you made. If you have multiple lines, Redial automatically uses the correct line.

**Hold**

During a call, press **Hold**. The line key flashes red. Press either the flashing line key or the **Resume** softkey to resume the call.
Transfer

There are three kinds of transfers:

**Assisted.** During a call press the Transfer button. Enter a number or press the Contacts softkey to find a number. Press the Dial softkey. When someone answers, inform them of the call to be transferred. Press the Transfer softkey to complete the transfer.

**Unassisted (blind).** During a call, press the Transfer button. Enter a number or press the Contacts softkey to find a number. Press the Transfer softkey to complete the transfer.

**Transfer to Voicemail.** If you used Contacts for a transfer, you can press the Transfer VM softkey instead of Transfer. That transfers the call to that contact’s voicemail.

Park

During a call, press the Park softkey. Then you or a coworker can answer the call from any Switchvox phone by either dialing that Parking extension or by pressing the Parked Calls softkey and answering the call. From the idle screen: press the More... softkey, then Parked Calls.

Record

During a call, press the Record softkey to begin recording. Press Stop Record when you are done. Recordings are in your voicemail mailbox.

Three-way Conference

During a call, press enter the Conf button or the Conference softkey on your phone. Dial the third participant’s number, or use Contacts. Press the Conference softkey to connect all participants. To split a conference into separate calls with each participant, press the Split softkey and select the participant to drop from the call. See Conferencing for more on conference calls.
Greetings

Greetings are recorded or uploaded sounds that play to a caller when you don’t answer the phone. You can upload a sound file from your computer, or record a greeting using your phone.

- The default greeting is Switchvox reading your extension digits, after which the caller can record a message.
- The greeting that Switchvox plays can be different if you are already on a call (Busy greetings) or if you are just not answering the phone (Unavailable greetings).
- If you don’t want to distinguish between Busy and Unavailable, set Use Unavailable greetings when busy to YES.
- You can create as many greetings as you want, but only one can be active for each situation (Busy, Unavailable, Full Name).

Notifications

Voicemail Notifications

Voicemail Notifications let you customize how you want to receive a notification when you get a voicemail message in Switchvox.

- You can set up multiple email addresses, each with an email template and instructions for attaching the voicemail as a WAV file.
• To add a new notification option, click **Create Notification**. Enter your email address, select a template, and select Yes or No to indicate whether or not to attach the voicemail WAV file to the email message.

• To modify a notification option, click its Modify icon.

• To delete a notification, click its Delete icon. You cannot delete the local copy notification (that is the copy in your Switchvox IMAP mailbox), but you can change the template. This is the template that you will see if you subscribe to your Switchvox IMAP mailbox using your desktop email application.

### Notification Templates

Notification Templates let you customize your voicemail notifications to your email address.

- You can create multiple templates and tailor them to different types of email accounts. These custom templates are available (along with default templates) when you create or modify a Voicemail Notification.
- You can use variables in your template that are substituted with real values when the email is sent.
  
  For example, `%VM_CALLERID%` in a template prints as the caller’s name and phone number. There is a full list of these variables on the pages where you create or edit a template.

### Fax Notifications

You can create email addresses to receive notifications of a new incoming fax. This is useful if you want to be notified at both your work and personal email addresses, or if you want your administrative assistant to be notified.

You can also modify or delete these email addresses.

---

### Mailbox

The Switchvox Mailbox lets you manage your voicemail and faxes in Switchvox.

Your Mailbox uses IMAP, a protocol that lets your desktop email application access remote messages as if they were stored on your computer. If you prefer to access your Mailbox from your desktop email, ask your Switchvox administrator for more information about how to do this.

### Voicemail

Your voicemail comes into the INBOX folder. Each message displays the original mailbox the message was left in (the message might have been forwarded to you by a
co-worker), the caller ID of the caller (if it was available), the date and time the message was left, and the duration of the message.

- To play or download a message, click its Play button. This marks the message as Read (it is no longer shown as bold, and the message-waiting indicator light on your phone would go off if this was your only unread message).
- To delete messages, or mark them as read or unread, check the box for each message that you want to affect. Then, click the appropriate icon (at the top of the list). If you delete messages, you are prompted to verify the action. Be sure that you really want to delete the messages, then click Yes, Delete.
- To move messages to a different folder, check the box for each message that you want to move, select the folder where the messages belong, then click Move To Folder.
- To forward messages to another Switchvox user, check the box for each message that you want to forward, select the extension to forward them to, then click Forward To.
- To sort by column in the message list, click the column name.

**Delete Local Copy**

Yes indicates that a voicemail message is deleted from your Switchvox Mailbox after it is sent to your email address. This option lets you handle your voicemail entirely through your own email account.

**Forwarding**

You can automatically forward all of this extension’s voicemail messages to other extensions in Switchvox. This is helpful for generic extensions such as “Accounting,” “Shipping,” or for queue extensions such as “Customer Service.” Callers can leave a message on one extension, then the message is forwarded to the appropriate people. This is also useful internally, if you want to send a message to everyone in a group.

- You can forward messages to an Extension Group, or to extensions. Choose one, then add the groups or extensions to the collection.
- To delete each message from this extension’s Mailbox after the message is forwarded, set Delete on Forward to YES.
- To send forwarded messages to all of the recipients, choose Send to All from the Forwarding Type dropdown.
- To send forwarded messages to one recipient at a time, choose Round Robin. With Round Robin, Switchvox forwards each message to the next recipient, moving through the list of recipients in the same order as they are listed. If you are using Extension Groups, the groups are used in the order they are listed in the collection, and in the order given within the group itself.

**Faxes**

Your faxes come into the Fax folder. Your outgoing faxes are stored in the folders Drafts, Outbox, and Sent. The Drafts folder includes the files that you have printed to your Switchvox fax printer. The Outbox folder includes faxes that Switchvox is cur-
rently trying to send (or was unable to send). The Sent folder includes faxes that Switchvox has successfully sent.

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

To send a fax, check its box (you can only send one fax at a time) then click the fax icon (at the top of the list). You are prompted to enter a fax number. Enter the number for the fax machine you want to send this fax to, then click Send Fax.

**IMPORTANT:** When you enter the fax number, be sure to prefix any digits that you normally use to dial out.

Your fax is in the Outbox folder while it is being sent, and moved to the Sent folder when it has been successfully sent. If Switchvox cannot reach the other fax number to send your fax successfully, it remains in the Outbox folder.

**NOTE:** Switchvox sends fax notification email messages. These notification messages show the status of your fax. A Pending fax is still being sent (a fax may be Pending for a little while if Switchvox has to try multiple times), a Sent fax has been sent successfully, and a Failed fax was never received by the fax machine at the number you indicated. For details on setting up fax notifications, see **Fax Notifications**.

- To preview page 1 of a fax, click **Preview**.
- To view or download an entire fax, click Download. This marks the fax as Read (it is no longer shown as bold).
- To delete faxes, or mark them as read or unread, check the box for each fax that you want to affect. Then, click the appropriate icon (at the top of the list). If you delete faxes, you are prompted to verify the action. Be sure that you do indeed want to delete the faxes, then click **Yes, Delete**.
- To move faxes to a different folder, check the box for each fax that you want to move, select the folder where the faxes belong, then click **Move To Folder**.
- To forward faxes to another Switchvox user, check the box for each fax that you want to forward, select the extension to forward them to, then click **Forward To**.
- To sort by column in the message list, click the column name.

For more information, see **Faxing**.

**Fax Options**

Fax Options let you set up your faxing environment. You can enter multiple email addresses to receive notifications of a new incoming fax, create a fax header, and define this extension as only sending faxes.

You must install a fax license and the fax software to make faxing available. For details, see Digium Addon Products.

**Sending and Receiving**

Sending and Receiving. These options control faxing for this extension.

**Treat All Outgoing Calls as Faxes**

Yes indicates that this extension is actually a fax machine and won’t make any voice calls. Switchvox handles all outgoing activity as a fax.

**Print a fax-file**

Put it in the Fax.OutOfbox folder in the extensions’s Mailbox

Send the fax
No indicates that this extension may make voice calls and send faxes.

**Fax Header**

This Fax Header is included on each fax that you send. For example:

Digium, Inc. | 256.428.6000 | Fax: 256.864.0464

This is the information that is printed along the very top of your fax pages (not to be confused with a cover page).

---

**Digium Phone Voicemail App**

The built-in Voicemail application for your Digium Phone allows you to use interactive voicemail directly from your desk phone. When you have unplayed messages, the message waiting indicator (on the top right of your phone) flashes red.

Press the **Msgs** button to display your Voicemail INBOX. Any message with an asterisk (*) has not been played. To listen to a message, select it and press the Play softkey.

---

**The Voicemail System**

When you call the Voicemail system, you have many options:

- Listen to a message
- Forward a message
- Save a message
- Send a reply message
- Call-back the person who left a message
- Navigate voicemail folders
- Record greetings
Putting the Mailbox on Your Desktop

Your Switchvox Mailbox uses IMAP, a protocol that lets your desktop email application access remote messages as if they were stored on your computer. In this case, it means that you can access your voicemail and faxes in your Switchvox Mailbox using your regular email application (e.g., Microsoft Outlook or Mozilla Thunderbird).

Your Switchvox Mailbox does not offer outgoing mail service, so if you want to forward a message or a fax from your email client, then you need to use your regular email account for that outgoing email message.

To set up your Switchvox IMAP Mailbox in your desktop email application, you’ll need the following information:

The IP address or domain name of your Switchvox mail server. This is the same IP or name that you use for the Switchvox Extension Suite.

Your email address, which in this case is your extension number, the @ sign, then your IP address or domain name. For example:

101@192.168.0.100 or 101@pbx.mybusiness.com.

Your user name, which in this case is your extension number.

Your password, which is the same password that you use to log into the Switchvox Extension Suite and to collect your voicemail.
In your email application, start the process to create a new Internet email account. When you are prompted to enter the type of incoming mail server for the account, choose IMAP. Enter the rest of the information as prompted.

**IMPORTANT:** If you are having trouble using your Switchvox IMAP account in your email application, talk with your Switchvox administrator. It is possible you need to use a different port number than the default (143), or you need to set specific security options.

**Subscribing to Folders**

After you have your Switchvox IMAP account set up in your desktop email application, you can manage the same folders that are in the Switchvox Mailbox (Voicemail / Fax > Mailbox).

You can subscribe to all of the folders, or just the ones you want to use. If you unsubscribe to a folder, it still exists in your IMAP account, it just isn’t shown in your email application. You can always subscribe to it again later.

You can also create folders using your desktop application, and those folders are accessible in your Web Suite Mailbox.

To subscribe to your IMAP folders in Microsoft Outlook, highlight your Switchvox IMAP Inbox and select Tools > IMAP Folders.

To subscribe to your IMAP folders in Mozilla Thunderbird, highlight the account and select File > Subscribe.

In both applications, the IMAP Folders window is displayed where you can subscribe and unsubscribe.
Faxing

The following sections describe how to set up a FAX printer and send a FAX:

Setting Up a FAX Printer

Ask your Switchvox administrator whether or not faxing is available on your Switchvox. To make faxes for Switchvox, you need to first set up a generic printer that you can use from any application. You only have to do this once.

Depending on your desktop environment there are many ways to set up a printer, but there is some specific information that you need to set up a Switchvox Fax Printer:

- For Windows-based operating systems, the URL is http://YourDomain:631/printers/faxprinter
  
  YourDomain is the domain that you normally use for Switchvox. This may be an IP address or a domain name.

- For Linux- or Macintosh-based operating systems, the URL is http://ext:password@YourDomain:631/printers/faxprinter
  
  ext is your extension
  password is the password that you use for Switchvox voicemail
  YourDomain is the domain that you normally use for Switchvox. This may be an IP address or a domain name.

- For any operating system, use a generic postscript printer driver:
  
  - For Windows-based operating systems, choose the generic driver MS Publisher Colored Printer.
  
  - For Linux- and Macintosh-based operating systems, choose the generic driver Postscript Printer.

Sending a Fax

After your fax printer is set up, you can create a fax from any application.

- In your document, select the Print option. In the Print dialog box, select the new ‘faxprinter’ as the printer to use, and print the file.

- Go to the Extension Suite Voicemail / Fax > Mailbox.

- Select Fax:Drafts from the View Folder dropdown. Your Fax.Drafts folder is opened, and your drafts are listed.
Sending a Fax

- The page you just printed is in the list. You can preview the first page, or download a PDF of the entire fax.
- Check the box for your fax
- Click the fax machine icon (at the top of the list).
- Enter the number for the fax machine you want to send this fax to.
- Click Send Fax.
- Your fax is in the Outbox folder while it is being sent, and moved to the Sent folder when it has been successfully sent.
7  

**Reporting**

These reporting features are described in the following sections:

- Call Logs
- Call Reports

---

**Call Logs**

A Call Log is a simple list of the calls that have been made to or by your extension. You can select a date range by setting the From and To dates. Click View Log to see the log within the browser window, or click Output to .xls file to download an xls file.

The Log includes the call date, who the call was from and to, the type of call (incoming or outgoing), the call time, and the talk time.

To see all of the details that Switchvox has for a call, click a call's Details icon.

Go to Reporting > Call Logs. This displays the Call Log page.

- Enter **From** and **To** dates to list calls for a date range.
- Click **View Log** to display the results at the bottom of the page under Call Logs. Click **Output to .xls File** to download an xls file of the log you can open with an application such as Microsoft Excel.

The Call Log results include the call date, who the call was from and to, the type of call (incoming or outgoing), the call time, and the talk time.

- To display the details Switchvox collected for a call, click the call's Details icon.

---

**Call Reports**

Call Reports lets you generate a call activity report based on a date-range and criteria you specify. Output can be in chart, list, browser, and XML form. Charts are only available for one breakdown field at a time.

Go to Reporting > Call Reports. This displays the Call Reports page.

- Enter **From** and **To** dates to process calls for a date range.
- Select **Yes** or **No** to ignore weekends if your organization is not active on weekends.
- Select a Report Breakdown from the dropdown. Options include
  - By Date
  - By Account
Call Reports

- By Hour of Day
- By Day of Week
- Total accumulative

- Select a Report Field from the list. Options include:
  - Total Number of Calls incoming and/or outgoing
  - Total Number of Outgoing Calls
  - Total Talking Time that this extension actively spent with the call
  - Total Call Duration, includes time spent in an IVR or waiting in a queue
  - Average Talk Time per Call
  - Average Call Time per Call

- Click Chart Report to display the results in a graph according to breakdown and report field selected.
- Click View Report to display results at the bottom of page in Call Report.
- Click Output to .xls File to download an xls file of the log you can open with an application such as Microsoft Excel.

The Call Report results include the call date and the field type data for that date.
Switchboard

Switchboard is a graphical display of what’s happening on Switchvox. It shows your own calls, your coworkers’ calls, call-queue activity, and your parking lot. You can drag and drop to transfer calls, and one click lets you make a call, pick up calls, record or monitor calls, log in and out of call queues, and more.

In addition to all of the Switchvox interaction, the Switchboard is also “Web Aware,” which means you can integrate other web applications with your call activity. Built-in panels bring SugarCRM, Salesforce, and Google Maps to the Switchboard, and you can build custom panels that use the URL of your choice.


Using the Switchboard

To open your Switchboard, click the Switchboard button in the upper right corner of the Extension Suite main page. This loads the Switchboard for your extension.

In the upper right of the Switchboard, you can see the number of voicemail messages you have, new and old. There are also an Options dropdown menu that lets you control your Switchboard and a My Status dropdown menu that lets you change your status.

Your Switchboard lets you have up to 6 active lines on your extension (in the Current Calls panel), regardless of your phone’s capabilities.

Options

The Options dropdown lets you control what is on your Switchboard, and how it is laid out. It also let you select the phone you want to use from your list of converged phones. The following describe the menu options.

NOTE: Your Switchvox administrator must give you permission to use many of the features. If you see a feature described here that is not available to you, ask your administrator.

Save Layout. Save Layout lets you save your Switchboard window and panel layout. The next time you open the Switchboard, the window is the same size, and the same panels are open in the same place.
Switchboard Panels

**Panels.** Panels let you open and close all of the Switchboard panels you have permission to use. Each of your Phonebooks is available as a separate panel. See the following sections for Panel descriptions.

**My Phone.** My Phone lets you select the phone you want representing you from a list of your converged phones.

---

**Switchboard Panels**

**Current Calls**

Current Calls displays all of the active calls on your extension and gives you many options for handling those calls. You can have as many as six current calls in the Switchboard, even if your handset does not support that many.

**NOTE:** To use a Converged Phone with your Switchboard, select that phone from the My Phone dropdown.

- **Send Call**
  If you choose not to answer a call, click **Send** to send the call to your Call Rules. The default rule is to send your calls to voicemail.

- **Hold & Resume**
  When you are on a call, click the **Hold** button to put the call on hold. The button then renames itself to **Resume**. Click **Resume** to return to the call.

- **Take Another Call**
  You can put an active call on Hold, then answer another incoming call. In fact, you can have as many as six current calls in the Switchboard, even if your handset does not support that many.

- **Transfer: Assisted & Blind**
  To transfer a call to someone in your Phonebook, just click the call and drag it from Current Calls to the Phonebook entry. You can transfer a call at any time, even if you have the call on hold, or the other extension is on an active call.

  In an assisted transfer, you put the caller on hold, call your coworker to let him/her know you’d like to transfer a caller, then complete the transfer. In a blind transfer, you would just drag the call to the Phonebook entry.

- **Transfer to Voicemail**
  To transfer a call to your coworker’s voicemail, just click the call and drag it from Current Calls to the Phonebook entry’s envelope icon. This is handy if you know your coworker isn’t able to take the call.

- **Record**
  When you are on a call, you can click to start and stop a recording of your call. The recording is sent to your voicemail Mailbox, where you can save or forward it. It is up to you to let the other party know you are recording the call.
**Directory**

Directory offers you access to an Internal Directory defined by your Switchvox administrator. You can click and drag a call to an entry in the Directory panel to transfer the call to that extension.

**Parking Lot**

Parking Lot lets you “Park” a call so the call can be picked up at a different extension. To Park a call, just click and drag the call to the Parking Lot panel. Then, you or any of your coworkers can pick up a phone and dial the Parking Lot extension to be connected to the caller.

**NOTE:** An extension must have permission to pick up a parked call.

**Profile**

Profile displays the profile of the extension owner you are talking to. Profile information can be entered by the Switchvox administrator, or by the extension owner. See “My Account” (page 9) for more about profiles.

Profiles can be shown in the Switchboard and on a phone that uses a Phone Feature Pack.

This panel also offers the following one-click options to reach extensions:

- **Chat**
  Start a chat with an extension.

- **Call**
  Call an extension. The Switchboard rings your phone, and then when you answer it rings the extension. (You may be able to set up your phone so it automatically answers calls from the Switchboard; see Auto-answer Switchboard initiated calls.)

- **Voicemail**
  Call the voicemail for the extension. The Switchboard rings your phone and after you answer, it rings the extension's voicemail box so you can leave a message. (You may be able to set up your phone so that it automatically answer calls from the Switchboard; see Auto-answer Switchboard initiated calls.)

**Phonebook**

Phonebook displays the entries in a Phonebook. You can click on any entry to dial that number. Some extensions can display as Extended Entries, to help you communicate more effectively with that person.

- **Normal Entries**
  Normal Phonebook entries show your coworkers’ extensions or your frequently dialed external phone numbers. Each extension is shown with its Presence information, and you can click on any of them to speed dial the extension or number.
Normal entries have plus (+) icons with options to dial that person’s Additional Numbers, chat, or Intercom.

**NOTE:** You must have permission to use Chat and Intercom. Chat may not be available if for some reason you can’t chat with that person.

### Extended Entries
Extended Phonebook entries have all of the normal extension options, but they also let you do the following with that extension’s calls:

- Pick up an incoming call
- See who the caller is
- Record the call
- Monitor the call (the callers do not hear you)
- Barge into the call (both callers hear you)
- Whisper on the call (only your co-worker hears you)

**NOTE:** You must have permission to use each of these options.

### Status
All Phonebook entries display the person’s Status, which helps you and your coworkers be selective about what calls to transfer to each other. An Away or Extended Away Status can include comments.

**Intercom.** All Phonebook entries can include the Intercom option, which lets you talk to a coworker through the speaker on his/her phone, and the recipient doesn’t need to pick up the handset to answer your call.

**NOTE:** You must have permission to use this.

**Pickup.** Extended Phonebook entries can include the Pickup option (the green ‘up’ arrow). One click and your coworker’s incoming call rings your extension also.

**NOTE:** You must have permission to use this.

**Record.** Extended Phonebook entries can include the Record option. One click records the call, and sends the recording to your voicemail Mailbox.

**NOTE:** You must have permission to use this.

**Monitor.** Extended Phonebook entries can include the Monitor option. If you monitor a call, the callers cannot hear you.

**NOTE:** You must have permission to use this.

**Barge.** Extended Phonebook entries can include the Barge option. If you barge into a call, both of the callers can hear you.

**NOTE:** You must have permission to use this.

**Whisper.** Extended Phonebook entries can include the Whisper option. If you whisper into a call, the caller cannot hear only (only the extension owner can hear you).

**NOTE:** You must have permission to use this.
**Chat**

Chat lets you text interactively with your Switchvox coworkers. The main page of the Chat panel offers a list of people you can double-click to start a chat. Or, enter a Jabber ID and click Start Chat.

**NOTE:** You must have permission to use this.

**Queue**

Each Call Queue panel in your Switchboard contains views into that queue’s activity and statistics for the day.

For queue members, you can log into or out of each queue with one click. Or, you can pause your status and add a comment, letting your co-workers know why you're unavailable and when you’ll be back.

**NOTE:** You must have permission to use this.

**CRM**

CRM panels integrate with your CRM application. When a call rings your phone, all of the information for this customer is displayed immediately, before you even answer the phone!

**NOTE:** You must have permission to use this.

**Google Maps**

Google Maps shows you where your caller is on a map based on area code and prefix. A popup window lets you scroll through previous callers’ locations.

**NOTE:** You must have permission to use this.

**Custom**

Your Switchvox administrator may have set up custom panels that integrate with Web applications. Ask your administrator for more information.
**Popup URLs**

Your Switchvox administrator can write external applications that set a display URL for each incoming call. If this value is set, then the URL button lights up and clicking it opens a new window with the specified URL. If you want that window to automatically open when a call comes in, click the green plus sign at the top-right of the panel.